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Câu  1. Để tạo một văn bản mới trong Word, ta thực hiện cách.

A. Nhấp đúp chuột lên màn hình nền 
 B. Vào Menu File chọn New

C. Ấn tổ hợp phím CTRL+O
 D. Ấn tổ hợp phím CTRL+Z

Câu  2. Biểu tượng ( trong Word có chức năng.

       A.Tạo 1 văn bản mới      
B.Xem văn bản trước khi in   

       C. In văn bản                  
D. Đóng khung 1 văn bản

Câu  3: Trong Word phím Enter có chức năng gì khi đang soạn thảo văn bản.


A.Xuống dòng tiếp theo




B.Xuống trang tiếp theo


       C.Xuống đoạn tiếp theo




D.Kết thúc Word

Câu  4. Phần mềm nào sau đây cho phép ta soạn thảo văn bản.


A.BKAV

B.Microsoft Word

C.Winamp

D.WinRAR
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 trong Word có chức năng.


A.Thu nhỏ màn hình
         


B.Phóng to màn hình


        C.Canh lề 2 biên văn bản


D.Canh giữa văn bản

Câu 6. Để tìm kiếm một từ hoặc cụm từ ta dùng phím tắt nào?


A. Ctrl+A
  B. Ctrl+F

C. Ctrl+G

D. Ctrl+H

Câu 7. Tổ hợp phím CTRL+V có chức năng.


A.Xoá văn bản

B.Đánh dấu văn bản      
C.Cắt văn bản   
D.Dán văn bản
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 trong Word có chức năng.


A.Xem văn bản trước khi in    B.Mở một văn bản       C.Đóng một văn bản
     D.Lưu một văn bản

Câu 9. Khởi động Word từ màn hình nền (biểu tượng Word) , ta có thể thực hiện cách.

A.Nhấp chuột trái và chọn Open

   B.Nhấp đúp chuột phải



C.Nhấp đúp chuột trái

       

   D.Cả ba cách trên đều được.

Câu 10. Để in 2 trang văn bản trong một tệp văn bản có nhiều trang ta thực hiện cách nào?
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A.  File/Print

B. Nháy nút

 C. Ctrl+P      D. Cả A,C đều đúng
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  trong Word có chức năng. 


A. Canh giữa văn bản

  

B. Đưa văn bản lên trên
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B A/Binh dang chit d4m v gach chin nét don B/Binh dang chit dm
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C. Canh lề hai biên văn bản


D. Thu nhỏ màn hình

Câu 12. Nháy nút 


        cho phép ta làm được gì?


A. Định dạng đoạn văn bản


B. Định dạng trang


C. Định dạng font chữ



D. Định dạng kiểu danh sách
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Câu 13. Để thay đổi kiểu chữ nghiêng ta sử dụng biểu tượng nào?


A.

    B.

       C. 

        D.

Câu 14. Để định dạng trang trong Word, ta thực hiện cách sau trên thanh Menu (thanh bảng chọn).


A. View/Page Setup    B. Tools/Page Setup     C. Table/Page Setup  D.File/Page Setup 

Câu 15. Biểu tượng                  có chức năng.

A.Đổi sang chữ in hoa


B.Thay đổi kích thước chữ 


C.Đổi sang chữ in đậm


D.Cả ba Câu  trên đều đúng 

Câu 16. Để sao chép một đoạn văn bản sau khi đã chọn, ta thực hiện


A. File/Copy    
  B. Edit/Send To
  C. Edit/Copy
              D. Cả ba cách đều sai

Câu 17. Muốn huỷ bỏ thao tác vừa thực hiện thì ta nháy nút


A. 

     B.


   C.


   D. 

Câu 18. Biểu   tượng ( có chức năng.


A.In văn bản hiện hành
 

B.Sao chép văn bản hiện hành



C.Lưu văn bản hiện hành   

D.Xem văn bản trước khi in
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   có chức năng;


A.Định dạng chữ đậm và gạch chân nét đơn

B.Định dạng chữ đậm





C.Định dạng chữ gạch chân



D.Định dạng chữ in hoa và gạch chân

Câu 20. Tổ hợp phím CTRL+S có chức năng.


A.Lưu 1 văn bản 
B.Đóng văn bản
C.In văn bản
          D.Sửa nội dung văn bản

Câu 21. Để hủy thao tác vừa thực hiện và quay lại những thao tác trước đó, ta ấn tổ hợp phím.


A. CTRL+Y

B. CTRL+J
   C. CTRL+Q

D.CTRL+Z
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B C20:Biéu momg  Z_ c6 chiic ning:

: A/Binh dang chit dam v nighiéng B/Bigh dang chit dm

R C/inh dang chi nghifng D/Binh dang chi in hoa va nghiéng Ll

B C21: Biéu tong L2 c6 chuie nang;

B A/Binh dang chit d4m v gach chin nét don B/Binh dang chit dm
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B €22: Pé Ity thao tac vira thpc hién va quay lni nltimg thao tic trugc @6, ta an t6 hop phim:

A/CTRL_Y B/CTRL_] CICTRL_Q D/CTRL_Z
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 là.

A.Thanh công cụ chuẩn

            B.Thanh bảng chọn (Menu)


C.Thanh trạng thái 


D.Thanh tiêu đề

Câu 23. Để lưu văn bản với tên khác hoặc vị trí khác ta thực hiện lệnh trên thanh menu.


A. File/Close
B. File/Save

C. File/Save As

D. File/Exit

Câu 24. Để mở tệp văn bản đã có, ta thực hiện:


A. Ctrl+O
B. Ctrl+B

C. File/ Open

D. Cả A, C đều đúng

Câu 25. Đánh số trang tự động, ta thực hiện:


A.Insert/Break          B. Insert/ Page Numbers     C. File/Page Numbers
 D. Ctrl+Enter

Câu 26. Để ngắt trang văn bản ta dùng tổ hợp phím. 


A. Shift+Enter
      B. Shift+Ctrl
C. Ctrl+Enter

D. Ctrl+Shift+Enter

Câu 27.Biểu tượng 

có chức năng


A. Phóng to màn hình
         B. In văn bản
             C. Tạo trang mới
           D. Xem trước khi in
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    có chức năng.

A. Canh lề trái văn bản
     B. Canh lề phải văn bản
C. Đánh chỉ số đầu mục      D. Chia cột văn bản

Câu 29. Phím tắt Ctrl +A   có chức năng.


A.Chọn một đoạn văn
 B. Chọn một dòng  C. Chọn toàn bộ văn bản     D. Chọn một số dòng văn bản
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A/CTRL_Y B/CTRL_] CICTRL_Q D/CTRL_Z
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 là thanh.

A. Thanh tiêu đề
B. Thanh công cụ chuẩn
C. Thanh định dạng
   D. Thanh bảng chọn
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B C20:Biéu momg  Z_ c6 chiic ning:

: A/Binh dang chit dam v nighiéng B/Bigh dang chit dm
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B C21: Biéu tong L2 c6 chuie nang;

B A/Binh dang chit d4m v gach chin nét don B/Binh dang chit dm

: C/inh dang chit gach chén D/Binh dang chit in hoa v gach chén

B €22: Pé Ity thao tac vira thpc hién va quay lni nltimg thao tic trugc @6, ta an t6 hop phim:

A/CTRL_Y B/CTRL_] CICTRL_Q D/CTRL_Z
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 là thanh.


A. Thanh tiêu đề       B. Thanh công cụ chuẩn     C. Thanh định dạng

D. Thanh bảng chọn

Câu 32. Để in văn bản hiện hành, ta vào menu.


A. File/Page Setup
B. File/Print Preview
C. File/Permission 
D. File/Print

Câu 33. Nếu đóng văn bản mà chưa lưu trước đó thì Word sẽ.


A.Không cho đóng 
  B.Treo máy    
C.Cảnh báo lưu
D.Đóng theo yêu cầu

Câu 34. Bảng chọn File có chức năng gì?

A. Chứa các lệnh xử lý tệp
B. Chứa các lệnh định dạng
C. Chứa các lệnh trợ giúp D. Chứa các lệnh hiển thị

Câu 35. Tổ hợp phím tắt Ctrl + V tương đương với


A. Copy

B. Cut

C. Paste
D. Undo

Câu 36. Nút lệnh 

dùng để


A. In một trang

B. In vài trang

C. In trang hiện hành

D. In toàn bộ

Câu 37. Để gõ tắt trong Word ta thực hiện


A. Tools/ AutoCorrect Options... 

B. Edit/AutoCorrect Options...


C. Format/AutoCorrect Options... 

D. File/AutoCorrect Options... 

Câu 38. Để thoát khỏi Word, ta vào Menu File và chọn lệnh.


A. Exit

B.Close
C.Save


D.Quit

Câu 39. Để gõ cụm từ "Tiếng Việt" theo kiểu gõ Telex thì ta gõ như sau:


A. Tiêng1Vieet5

B. TieengsVieetj
C. TiengsVieetj
D. TiengsVietj

Câu 40. Để định dạng kiểu danh sách ta thực hiện


A. Format/ Bullets and Numbering...

B. Insert/ Bullets and Numbering...


C.File/ Bullets and Numbering...

D. Edit/ Bullets and Numbering...


Câu 41: Để tổ chức mạng máy tính không dây đơn giản, cần có?


A. Diểm truy cập không dây.         B. Chỉ cần có máy tính lag được.


C. Vỉ mạng không dây.                   D. Phái có ít nhất mục A và C  


Câu 42: Dưới góc độ địa lí, mạng máy tính được phân thành:


A. Mạng toàn cục, mạng cục bộ, mạng diện rộng.

B. Mạng toàn cục, mạng diện rộng, mạng toàn cầu. 


C. Mạng toàn cầu, mạng diện rộng , mạng cục bộ. 


D.Mạng toàn cầu, mạng toàn cục, mạng diện rộng.       

Câu 43: Kết nối các máy tính là ……….. giữa các máy tính ? Hãy lựa chọn và điền vào chỗ trống.

A. Hệ thống trao đổi thông tin.                 B. Truyền tải thông tin.

C. Tổ chức việc truyền thông.                  D. Sắp xếp thông tin.

Câu 44 :  Kết nối máy tính cho phép làm gì ?

A. Sử dụng chung các thiết bị.                   B. Sử dụng chung các phần mềm.

C. Truyền tải thông tin từ máy này sang máy kháC.   D. Tất cả a , b , c đều đúng. 

Câu 45 :  Khi kết nối các máy tính thì không cần thiết bị nào sau đây ?

A. Card mạng.                B. HuB.                 C. Mouse.                       D. Switch.

Câu 46 :  Dữ liệu cần truyền đi trong mạng phải được tổ chức như thế nào?

A. Các gói tin.                                     B. Các lớp tin.

C. Các nhóm tin.                                  D. Các tổ hợp tin.

Câu 47 :  Bộ các quy tắc tuân thủ trong việc trao đổi thông tin giữa các thiết bị nhận và truyền dữ liệu được gọi là gì?

A. Luật trao đổi thông tin.                  B. Quy tắc truyền tải thông tin.

C. Giao thức truyền thông.               D. Giao tiếp truyền thông.

Câu 48 :  Dữ liệu cần truyền đi trong mạng phải được tổ chức thành các gói tin có kích thước xác định . Đúng hay sai?

A. Đúng . 

B. Sai.

Câu 49 :  Khi đang sử dụng máy tính này nhưng chúng ta cũng có thể lấy tài nguyên từ các máy tính khác . Chúng ta đang sử dụng mô hình gì ?

A. Mô hình khách - chủ.                         B. Mô hình ngang hàng. 

C. Mô hình khách chủ - ngang hàng.     D. Cả a , b đều sai.

Câu 50: Trong kết nối mạng máy tính có dây, cáp được nối vào máy tính qua....?

A. Bộ định tuyến.      B. Bộ tâp trung      C. Giắc cắm.       D. Bộ khuyếch đại 

Câu 51: Trong mạng máy tính, thuật ngữ LAN là gì?

A. Mạng toàn cầu.   B. Mạng cục bộ.   C. Mạng diện rộng.   D. Một ý nghĩa khác

Câu 52: Qua internet có thể cho chúng ta làm được gì ?

a. Đăng ký học thêm một trường khác.                    b. Tìm tài liệu ở một thư viện khá.

c. Biết được mọi thông tin về thế giới của mình.     d. Cả a, b , c đều đúng. 

Câu 53: Trong mạng máy tính, thuật ngữ WAN là gì?

A. Mạng cục bộ.    B. Mạng diện rộng.    C. Mạng toàn cầu.   D. Một ý nghĩa khác.

Câu 54 :  Hãy điền lần lược (cụm từ) thích hợp"§Ó tham gia vµo m¹ng, m¸y tÝnh cÇn cã ...... ®­îc nèi víi ...... nhê ....."

A. giắc cắm - vỉ mạng - cáp.             B. vỉ mạng - cáp - giắc cắm.

C. cáp - giắc cắm - vỉ mạng.             D. giắc cắm - cáp - vỉ mạng.

Câu 55: Internet cung cấp nguồn tài nguyên cho những ai?

a. Các quốc gia tài trợ cho internet.     b. Các doanh nghiệp tài trợ cho internet.

c. Tất cả mọi người.                             d. Tất cả a , b , c đều sai. 

Câu 56  :  Một mạng máy tính bao gồm những gì?

A. Phần mềm cho phép thực hiện viêc giao tiếp giữa các máy tính.

B. Các máy tính và các thiết bị đảm bảo kết nối giữa chúng.

C. Một nút và một kênh.                 D. Cả A , B đều đúng.               E. Cả B, C đều đúng

Câu 57: Trong mô hình khách - chủ. Máy khách là máy:

A. Thường có cấu hình mạnh, lưu trữ được lượng lớn thông tin.

B.  Bảo mật tài nguyên dùng chung rất tốt 

C. Đảm bảo việc phục vụ máy chủ.

D. Sử dụng tài nguyên do máy chủ cung cấp.

Câu 58:  Một kiểu bố trí mạng gồm một trung tâm điều khiển và các nút thông tin được nối vào
 trung tâm này.Thiết bị trung tâm có nhiệm vụ nhận tín hiệu từ các trạm và chuyển đến 
đích. Đây là mạng gì?

A. Mạng hình sao.     B.  Mạng vòng.      C. Mạng đường thẳng.
D. Tất cả a, b , c đều sai
Câu 59 :  Để các máy tính giao dịch được với nhau cần có gì ?

A. Liên kết truyền thông.                     B. Giao tiếp truyền thông.

C. Giao dịch truyền thông.                  D. Giao thức truyền thông. 

Câu 60: Chọn từ thích hợp trong các (cụm từ) :"Mạng máy tính chỉ hoạt động được khi  các.....trong mạng được......với nhau và tuân thủ các......thống nhất"

A. máy tính, kết nối vật lí, quy tắc truyền thông.

B. quy tắc truyền thông, máy tính, kết nối vật lí.

C. máy tính, quy tắc truyền thông, kết nối vật lí. 

Câu 61: Một giao thức có chức năng truyền lại các gói tin có lỗi , phân chia thông tin thành gói nhỏ và phục hồi thông tin gốc ban đầu từ các gói tin nhận được. Đây là giao thức nào?

A. TCP.                     B. HTTP.                     C. IP.                      D. Bộ TCP/IP.

Câu 62: Giao thức chịu trách nhiệm về địa chỉ và định tuyến đường truyền cho phép các gói tin truyền qua một số mạng  trước khi đến đích . Đây là giao thức nào?

A. IP.                  B. TCP.              C. HTTP.                  D. WWW.

Câu 63: Giao thức thực hiện khôi phục thông tin gốc ban đầu từ các gói tin nhận được và hủy các gói dữ liệu trùng lặp. Đây là giao thức nào? 

A. TCP/IP.                   B. IP.         C. TCP.               D. HTTP.

Câu 64: Vì sao các gói tin đến đúng người nhận ?

A. Vì các gói tin có địa chỉ và có máy tính dãn đường.

B. Vì các máy tính trong mạng có địa chỉ riêng.

C. Vì có kết nối mạng và máy tính dẫn đường.

D. Vì các máy tính trong mạng có địa chỉ riêng và có máy tính dẫn đường dựa vào địa chỉ của gói tin để chuyển gói tin đến đúng người nhận. 

Câu 65: Các thông tin trên internet thường được tổ chức dưới dạng nào ?

A. Văn bản.       B. Gói tin.            C. Siêu văn bản.            D. Văn bản và hình ảnh.

Câu 66: Siêu văn bản dưới góc độ của người sử dụng là tổng thể bao gồm những gì ?

A. Văn bản và hình ảnh.                                     B. Văn bản ,hình ảnh và âm thanh.

C. Văn bản , hình ảnh , âm thanh,video và các liên kết.         D. Cả b , c đều đúng.

Câu 67: Để tìm kiếm và thâm nhập các tài nguyên của internet, người ta sử dụng hệ thống ?

A. HTTP.               B. TCP/IP.            C. WWW.              D. Cả a , c đều đúng.

Câu 68: WWW là viết tắt của cụm từ nào dưới đây ?

A. Work wide web.                     B. World wide web. 

C. Wide work web.                     D. Widing world web.

Câu 69: Trong Internet, thuật ngữ HTTP là:

A. Giao thức truyền tin văn bản.

B. Giao thức để gởi và nhận thư điện tử.

C. Giao thức truyền tin siêu văn bản.

D. Ngôn ngữ để tạo tệp siêu văn bản.

Câu 70: HTML là một ngôn ngữ gì?

A. Siêu văn bản.                            B. Lập trình.

C. Định nghĩa kiểu.                       D. Đánh dấu mở rộng.

Câu 71: Có hai trình duyệt web thông dụng nhất , là hai trình duyệt nào?:

A. Internet explorer và notepad             B. Internet explorer và netscape navigater. 

C. Internet explorer và front page.        D. Netscape navigater và front page.

Câu 72: Thư điện tử là dịch vụ thực hiện việc……….. trên internet thông qua các hộp thư điện tử ? Hãy chọn câu trả lời đúng để điền vào chỗ trống.

A. Chuyển tải thông tin.                   B. Chuyển thông tin. 

C. Truyền thông tin.                         D. Vận chuyển các văn bản.

Câu 73: Mỗi hộp thư điện tử được gắn với một địa chỉ thư điện tử duy nhất có dạng như thế nào ?

A.<tên truy cập>@<địa chỉ máy chủ của hộp thư>. 

B. <địa chỉ máy chủ của hộp thư>@<tên truy cập>.

C. <tên truy cập><địa chỉ máy chủ của hộp thư>@.

D. Cả b , c,  đều sai.

Câu 74: Trong các thiết bị sau đây, thiết bị nào không phải là thiết bị mạng.

A. Vỉ mạng            B. Modem            C. Webcam            D. Hub

Câu 75: Trong phương thức kết nối mạng máy tính có dây, có mấy kiểu bố trí các máy tính trong mạng?

A. 2                        B. 4                         C. 3                       D. 5

Câu 76: Địa chỉ thư điện tử nào sau đây là hợp lệ?

A. Quangnam.fpt.vn@                           B.Quangnam@yahoo.com

C. Quangnam.yahoo@.com                   D. Quangnam@.yahoo.com

Câu 77: Đê kết nối Internet qua đường điện thoại, cần phải có loại thiết bị nào ?

A. Máy điện thoại cố định                      B. Hub

C. Modem                                             D. Cổng USB

Câu 78: Trong tin học, thuật ngữ Network là gì ?

A. Địa chỉ máy chủ cung cấp hộp thư điện tử.

B. Mạng máy tính.

C. Giao thức truyền thông.

D. Một loại thiết bị kết nối mạng.

Câu 79: Trong chế độ bảng, để gộp nhiều ô lại thành một ô, ta thực hiện:

A. Table- Split Cells.                      B. Tools- Split Cells.

C.Table- Merge Cells.                   D. Tools- Merge Cells.     

Câu 80. Trong Winword, tạo bảng :
A. Insert,Insert Table                   B. Table, Insert,Table

C. Tool Insert, Table                    D. Insert ,Table

 Câu 81: Để tạo chữ cái lớn đầu đoạn văn trong Word, ta chọn:

A. Insert → Drop Cap..                     B. Format → Drop Cap..

C. Tools → Drop Cap..                     D. Nhấn tổ hợp phím Ctrl + P
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